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Two-Minute Activity 
 

1. Open the Hot Potatoes JMix  
2. Type in an exercise title 
3. Type in the sentence. One word at a time with punctuation on a separate line. 
4. Click Save as “Web exercise” 
5. Click “View the exercise in my browser” 
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Creating a Hot Potatoes JMix Activity 
http://hotpot.uvic.ca/wintutor6/jmix1.htm 
http://hotpot.uvic.ca/wintutor6/jmix2.htm  

 
JMix creates scrambled sentence exercises. Students can be given single words, collocations, phrases or any 
combination of words to reorganize into a good sentence. Multiple correct answers can be accepted, including the 
sentences that don\t use all of the elements. A Hint button can be displayed, allowing the student to see the next correct 
word(s) in his/her solution.  
 
Getting Started 
Open up the Hot Potatoes software and click on the link to the JMix feature. You are now presented with the 
following screenshot of a blank JMix. 
 

 
 

 
1. Click into the Title text box and enter the title of your JMix. 
 
2. Enter the sentence in the Main sentence area. Put each word/segment on a different line. 

 
3. Enter another correct answers in the Alternate sentences area. Once you have completed your quiz, save it 

by clicking on the     ‘Save the exercise to disk’ icon. The ‘File Name’ dialogue box will appear. 
Type in your quiz name and save it in the appropriate folder. This will be saved as a Hot Potatoes jCross 
file 

 

2. This is where 
you enter the main 
sentence, which 

will be mixed up to 
create the 

exercise. Break up 
the sentence by 

putting each word/ 
segment on a 
separate line. 

1. The title of 
the exercise you 
are working on 
should be 
entered in this 
box. It will 
become the 
main title of the 
Web page you 
create. 

3. You may wish 
to allow alternate 
correct sentences 
that will be 
accepted by the 
program. You can 
enter any number 
of alternate 
sentences in these 
spaces. 

Setting the 
options here 
allows the 
program to 
check the 
alternate 
sentences 
when you 
start to create 
a Web page. 
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4. Next, you need to save the quiz as an HTML file. This is the format that students. Click on the   
‘Export to create a Hot Potatoes Version 6 Web Page’ icon. The ‘File Name’ dialogue box will appear. 
Type in your quiz name and save it in the appropriate folder. This will be saved as an HTML file.  

 
5. The following dialogue box will automatically appear. Click on ‘View the exercise in my browser’ option 

to see your new quiz. (Click ‘Nothing’ if you don’t want to view it.) 
 

 
 

 
Notes 
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Creating a Hot Potatoes JQuiz Activity 
http://hotpot.uvic.ca/wintutor6/jquiz1.htm  

 
JQuiz can create four different types of question: multiple-choice, short-answer, hybrid (a short-answer question that 
turns into a multiple-choice question after several attempts), and multi-select (in which the learner has to choose several 
of a set of options, then check the choices). 
 
Getting Started 
Open up the Hot Potatoes software and click on the link to the JQuiz feature. You are now presented with the 
following screenshot of a blank JQuiz. 

 
 

 
1. Click into the Title text box and enter the title of your quiz. 
 
2. Below the title, you will see the Q1 display and the option to scroll up/down. This allows you to select 

each question. 
 

3. Select the type of quiz you want to use – Multiple Choice, Short Answer, Hybrid or Multi Select. 
 

4. Enter the answers the quiz question. Remember there can only be one correct answer. The others could be 
close, or totally wrong. The objective is to encourage learners to think about their answer. 

 
5. Ensure you identify which of the answers is the correct answer by checking the correct box. 

 

1. Enter a quiz 
title 

2. Select 
question 
number 

3. Select which 
question type 

you want 

4. Enter Quiz 
answers 

5. Check box to 
identify correct 

answer 

6. Enter some custom 
feedback for learners 

when they select 
answers (not 
necessary) 
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6. Each answer should have some feedback. Have fun, but be constructive in your feedback. (If you leave 
these blank the user will receive the default feedback for correct and incorrect responses be selecting 
Configure Output under the Options menu and clicking in the Prompts/Feedback tab. 

 

7. Once you have completed your quiz, save it by clicking on the     ‘Save the exercise to disk’ icon. 
The ‘File Name’ dialogue box will appear. Type in your quiz name and save it in the appropriate folder. 
This will be saved as a Hot Potatoes JQuiz file. 

 

8. Next, you need to save the quiz as an HTML file. This is the format that students. Click on the   
‘Export to create a Hot Potatoes Version 6 Web Page’ icon. The ‘File Name’ dialogue box will appear. 
Type in your quiz name and save it in the appropriate folder. This will be saved as an HTML  file.  

 
9. The following dialogue box will automatically appear. Click on ‘View the exercise in my browser’ option 

to see your new quiz. (Click ‘Nothing’ if you don’t want to view it.) 
 

 
 

Notes 
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Creating a Hot Potatoes JCloze Activity 
http://hotpot.uvic.ca/wintutor6/jcloze1.htm  
http://hotpot.uvic.ca/wintutor6/jcloze2.htm  

 
JCloze creates gap-fill exercises. Several correct answers can be specified for each gap, and the student can ask for a 
hint and see a letter of the correct answer. Automatic scoring is also included. The program allows gapping of selected 
words, or the automatic gapping of every x word in a text. 
 
Getting Started 
Open up the Hot Potatoes software and click on the link to the JCloze feature. You are now presented with the 
following screenshot of a blank JCloze. 

 
 

1. Click into the Title  
text box and enter the 
title of your JCloze. 

 
2. Enter the main body 

of text  [you can also copy and 
paste text into this field] 

 
3. After adding the text, click and 

highlight the word you wish to 
make into a ‘gapped’ word and 
click on the ‘Gap’ button. The 
‘Gapped Word Alternatives’ 
dialogue box appears. 

 
 

1. Enter a 
JCloze title 

2. Main body 
of text 

Sequential gap 
number. Scroll 

up/down 
This is the 

highlighted gap 
word 

Give your learners a 
clue (optional) 

List alternative 
good answers 

Creates a gap 
in the reading 

text.  

Clear all gap 
words 

Create gap 
words every 
‘n’th word. 
Clear all 

existing gaps 
first. 

Opens the 
“Gapped word 

alternatives 
“dialogue box 

to edit alternate 
words or clues. 
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4. Once you have entered all your information into the ‘Gap Word Alterations’ dialogue 
box, keep repeating the process until you have finished. 

5. Once you have completed your quiz, save it by clicking on the     ‘Save the exercise to disk’ icon. 
The ‘File Name’ dialogue box will appear. Type in your quiz name and save it in the appropriate folder. 
This will be saved as a Hot Potatoes jCloze  file. 

 

6. Next, you need to save the quiz as an HTML file. This is the format that students. Click on the   
‘Export to create a Hot Potatoes Version 6 Web Page’ icon. The ‘File Name’ dialogue box will appear. 
Type in your quiz name and save it in the appropriate folder. This will be saved as an HTML  file.  

 
7. The following dialogue box will automatically appear. Click on ‘View the exercise in my browser’ option 

to see your new quiz. (Click ‘Nothing’ if you don’t want to view it.) 
 

 
 

Notes 
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Creating a Hot Potatoes JCross Activity 
http://hotpot.uvic.ca/wintutor6/jcross1.htm 

 
JCross creates crossword puzzles which can be completed online. You can use a grid of up to 100 x100 letters. As in 
JQuiz and JCloze, a hint button allows the student to request a free letter if help is needed. 
 
Getting Started 
Open up the Hot Potatoes software and click on the link to the JCross feature. You are now presented with the 
following screenshot of a blank JCross. 
 

 
 

1. Click onto the ‘Create a grid layout 
automatically from a list of words’ 

icon’   
 

The “Create a crossword grid 
automatically window” opens. 

 
2. Enter your crossword answers into the 

text box. One answer per line. 
 
3. When you have finished adding all of 

your crossword answers, click on the 
‘Make the grid button’. The grid is 

1. Create an 
automatic 

crossword grid 

Main 
Crossword 

Grid 

2. Enter the crossword answers 
(words) here, one per line. 

3. Click here when 
you have finished 

adding your 
crossword 
answers. 
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automatically created, encompassing your crossword answers and you will be presented with the screen 
shot below. 

 

 
 
 

4. You now need to add your crossword clues.  
5. If you click on each answer in turn, your cursor will automatically drop into the crossword question field. 

Add your question and then click on the OK button. Your clue automatically moves to the ‘Clues’ field.  
Move to the next answer and repeat the process until you have completed adding all of your clues. Finally, 
click on the OK button at the bottom of the screen. 

 

 
 

4. Add the 
crossword clues 

5. Click on each 
answer (word) and 
then add each clue. 

Enter the clue for each 
word/ answer here 

Submit crossword 
question (after 
entering each 

clue) Final OK Button 
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6. Once you have completed your quiz, save it by clicking on the     ‘Save the exercise to disk’ icon. 
The ‘File Name’ dialogue box will appear. Type in your quiz name and save it in the appropriate folder. 
This will be saved as a Hot Potatoes JCross file. 

7. Next, you need to save the quiz as an HTML file. This is the format that students. Click on the   
‘Export to create a Hot Potatoes Version 6 Web Page’ icon. The ‘File Name’ dialogue box will appear. 
Type in your quiz name and save it in the appropriate folder. This will be saved as an HTML file.  

 
8. The following dialogue box will automatically appear. Click on ‘View the exercise in my browser’ option 

to see your new quiz. (Click ‘Nothing’ if you don’t want to view it.) 
 

 
 
Notes 
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Creating a Hot Potatoes JMatch Activity 

http://hotpot.uvic.ca/wintutor6/jmatch1.htm 
http://hotpot.uvic.ca/wintutor6/jmatch2.htm 

 
JMatch creates matching or ordering exercises. A list of fixed items appears on the left (these can be pictures or text), 
and next to each one there is a drop-down list box containing a jumbled set of pieces of text. This can be used for 
matching vocabulary to pictures or translations, or for ordering sentences to form a sequence or a conversation. 
 
Getting Started 
Open up the Hot Potatoes software and click on the link to the JMatch feature. You are now presented with the 
following screenshot of a blank JMatch. 
 

 
 

1. Click into the Title text box and enter the title of your JMatch. 
 
2. Enter the items/sentences that will remain ordered on the left hand side of the exercise. 

 
3. Item navigation buttons to move up and down the item lists, 

 
4. Option to set some default display text. 
 
5. Enter the matching items which will appear as jumbled items in the exercise. 

 

1. Enter a 
JMatch title 

2. Enter the items / 
sentences that will 
remain ordered on 

the left of the 
exercise 

5. Enter the 
matching items 

that will be 
jumbled in the 

exercise 

3. Item 
navigation 

buttons to move 
up and down the 

item lists 

6. Option to ‘fix’ 
one or multiple 

items on the right 
hand side to 
prevent from 

jumbling. Can be 
used ‘as an 

example’ 4. Set some 
default display 

text 
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6. Option to ‘fix’ one or more items on the right hand side of the JMatch page, so they can’t be jumbled up. 
Can be used effectively as an example.  

 

7. Once you have completed your quiz, save it by clicking on the    ‘Save the exercise to disk’ icon. 
The ‘File Name’ dialogue box will appear. Type in your quiz name and save it in the appropriate folder. 
This will be saved as a Hot Potatoes JMatch file. 

 

8. Next, you need to save the quiz as an HTML file. This is the format that students. Click on the   
‘Export to create a Hot Potatoes Version 6 Web Page’ icon. The ‘File Name’ dialogue box will appear. 
Type in your quiz name and save it in the appropriate folder. This will be saved as an HTML  file.  

 
9. The following dialogue box will automatically appear. Click on ‘View the exercise in my browser’ option 

to see your new quiz. (Click ‘Nothing’ if you don’t want to view it.) 
 

 
 
 

Notes 
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How to Embed a YouTube Video in a Hot Potatoes Activity 
 
These instructions explain how to embed a YouTube video on the left side of a Hot Potatoes window, (next to 
the questions). 

1. Select Add Reading Text from the File menu in a JQuiz, JMatch, JCloze, JCross or JMix window.  
2. Select the Include a reading text check box in the Add Reading Text window. 
3. Open your web browser and navigate to the target YouTube video. 
4. Click the Share button below the video (on the YouTube page). 
5. Click the Embed button (now visible below the Share button). 
6. Scroll down the page. Stop scrolling when you see Custom with two empty boxes (Width and Height) 

below it.  
7. There are four buttons for different four pre-set video sizes to the left of the Custom Width/ Height 

option. Click on the first pre-set video size, i.e. the smallest (e.g. 420 X 315).  
8. Copy the embed code in the text box above “After making your selection, copy and paste the embed 

code…” 
9. Return to the Hot Potatoes window. 
10. Click in the reading text box, (below Title in the Add Reading Text window). 
11. Paste the embed code (copied from YouTube in Step 8). 
12. Click OK to close the Add Reading Text window. 
13. Select the Create a web page option in the File menu or by clicking the “Export to create … a Web 

page” button in the toolbar.  
14. Click Save if in a suitable location. 
15. Click	  View	  the	  exercise	  in	  my	  browser	  to	  preview	  the	  activity.	  

 
How to Install Hot Potatoes 

1. Go to http://hotpot.uvic.ca/ 
2. Click Downloads 
3. Click on the hyperlink, Hot Potatoes 6.3 installer (for the Windows version) 

(Mac users click Download Java Potatoes follow instructions provided on the same web page.) 
4. Click Run. 
5. Click OK to confirm English is the selected setup language 
6. Click Next 
7. Click I accept the agreement if you agree with the terms of installation 
8. Click Next 
9. Click Next after reading the Hot Potatoes information screen 
10. Click Next to install the program in the default location (Otherwise use the Browse button to change 

the location.) 
11. Click Next (to select the location of the shortcuts in the start-up menu) 
12. Click Next  (to confirm the shortcut placed on the desktop or Quick launch menu) 
13. Click Install 
14. Click Finish (and make sure the Launch Hot Potatoes is selected) 
15. Hot Potatoes will start (or launch it manually if needed) 
16. Click Use English 
17. In order to unlock all the features of the Hot Potatoes, you need to register the programs. 
18. Click the Help menu and select Register 
19. Type your name in the User name text box 
20. Click OK 
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Supplementary Tutorials for Downloading and Installing Hot Potatoes 
 

• http://www.slideshare.net/keithpeter/installing-hot-potatoes-on-windows-xp 
• http://www.youtube.com/watch?v=GCFENMAdlrk  
• http://www.youtube.com/watch?v=A2QqDIM9CWE 

 
Hot Potatoes Help Manual 
 

• Official Hot Potatoes Help booklet - http://hotpot.uvic.ca/hotpot6_help.pdf 
 


